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In addition to the table of contents, we have included several other navigational aids in this manual.
Special icons will alert you to items of particular significance:

A useful tip or cool feature.

Take note, be cautious, read carefully.

ALERT - Extreme caution.

____________________________________________________________________________________
Page 3

____________________________________________________________________________________

Caveats Before You Start
Because of limitations on target platforms (e.g. PC and iOS) for Remote Voice Tracking
purposes, your audio library must be in either PCM Wave or CBR MP3 format, even though
Simian supports other formats.
Simian itself supports PCM Wave, CBR MP3, Mpeg2, and ADPCM format audio. Because of Simian
Gateway’s necessity to cut/trim and compress intro and segue audio files for use with the Remote Voice
Track Editor, and the limitations of the remote platforms (e.g. PC and iOS platforms), the Simian Gateway
only supports PCM Wave and CBR MP3 audio files. This means that any audio files you want to be able
to use for remote voicetracks (your songs), must be in either PCM Wave or CBR MP3 format. If they are
not, you will need to use an external third-party utility to convert them to either of the above formats.
Since Simian Gateway/Remote communications are not encrypted, it is recommended that
you configure a third-party VPN to secure your connection if you desire an encrypted
connection.
Simian Gateway/Remote’s network communications are not encrypted. If you desire an encrypted
connection, it is recommended that you set up a third party VPN connection so that all communications
from your remote location to your studio are secure.

Be aware of your data usage when using wireless data contract devices since remote voice
tracking has the potential to transfer large amounts of data.
Since it is possible to connect using devices that utilize 3G or 4G cellular or over-the-air internet services,
you will need to be aware of your data usage, as most wireless internet services charge on a data-usage
type of contract. Simian Remote has the possibility to use large amounts of data if configured to use
large files for intro/segue cuts, and uploading of recorded Voice Tracks. Keep your data usage in mind
when configuring and using the Simian Gateway and Simian Remote clients!
Simian Gateway creates highly compressed intro and segue cuts of your audio files when
creating Remote Voice Tracks. To allow this functionality, you must have a compatible MP3
codec installed capable of encoding CBR MP3 files at low bitrates.
Since the Simian Gateway creates highly compressed intro and segue cuts of your audio files when
creating Remote Voice Tracks, an MP3 codec is required. Simian Gateway does not contain an internal
codec, so you must have a compatible MP3 codec installed capable of encoding CBR MP3 files, such as
the CyberLink MP3 ACM Codec (which BSI has available for a nominal license fee) or other third party
codec.

If you are going to be accessing your Simian Gateway from outside your local area network
(e.g. the internet), you’ll need to configure Port Forwarding on your network’s router to allow
two ports to connect to your Simian Gateway computer.
Simian Gateway uses two ports for a Simian Remote Client to fully connect. The first port is for data
communication, and the second is for file transfers. If you want to allow Simian Remote clients to access
your Simian Pro host across the internet, you’ll need to be able to configure the port forwarding/NAT
functionality of your router hardware. If you don’t wish to allow file transfers (e.g. Remote Voice Tracking,
etc.), you only need to forward a single port to your Simian Gateway machine, and you’ll need to disable
the Enable File Transfer Port option on the Simian Gateway’s main user interface.
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Quick Start
This section is designed for those of you who don’t want to (or don’t have the time to) read the full
manual. We will go over the basics of how to connect the Simian Gateway to a Simian Host machine with
the default settings. For further information about the Simian Gateway and all it’s options and functions,
you will need to check out the rest of the manual.
This section assumes you have Simian Pro, Simian Gateway, and a Simian Remote client installed and
ready to run.

Configuring Your Simian Pro Host
The Simian Gateway application requires a connection to your instance of Simian via TCP/IP. You must
configure and enable these settings before the Simian Gateway will be able to connect to your instance of
Simian. The Simian Gateway is the remote connection management application that Simian Remote
clients connect through.
To configure the Remote Gateway Connection
settings in Simian Pro, go to the Tools menu
and choose Hardware Options.
On the
Network tab, place a check in the Enable
Remote Gateway Connection check box.
The Connection Password is the password
your instance of Simian will require for a
Simian Gateway application to connect. For
the purposes of this Quick Start, leave this
field blank.
The TCP Port field needs a valid, available
port number. For this Quick Start, leave this
at the default 6500.
The Data Refresh Rate dropdown determines
the playback deck update cycle speed from
Simian to the Simian Gateway. Leave this at
the default setting of “Normal”.

Figure 0.1

Configuring Simian Gateway
Now that the Simian Gateway Connection settings are configured in Simian Pro, you are ready to connect
the Simian Gateway to Simian Pro to allow Simian Remote clients to connect.
Open
the
Simian
Gateway
application by going to the
Windows Start menu, and clicking
on the Simian Gateway listing
within the Broadcast Software
listing in the Programs section.
If the Simian Gateway user
interface shown at right does not
appear, look in your system tray
icon and click on it.
for the
The user interface at right should
appear.

Figure 0.2: The Simian Gateway’s main user interface
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The first time you run the Simian Gateway, you will be informed that you do not have a properly
configured MP3 codec. You will need to choose a compatible MP3 ACM codec so that the Simian
Gateway can create intro and segue cuts for the Remote Voice Track editor.
To configure your MP3 codec, if you
aren’t automatically presented with the
Simian Gateway Program Options
window shown at right, click on the
Options menu on the main user
interface (figure 0.2) and it will appear.
Select an MP3 codec, such as the
CyberLink MP3 codec shown selected
in Figure 0.3 (this is a separate install
from the Simian Gateway), then select
a CBR MP3 format. The lower the
kbps, the smaller the intro and segue
files will be. The higher the kbps, the
larger and better quality the file will be.

Figure 0.3: Simian Gateway’s Program Options window

Simian Gateway has also been extensively tested and works well with the LAME MP3 ACM
codec. The limitation with this codec is that it is Open Source, and is only free for noncommercial usage.
Once you have chosen your MP3 codec, you will also need to set up each of the Paths directories to
match the locations each file type on your Simian Pro system.
•

Audio Database – The location of the audio.mdb file. This is located in C:\BSI32\ when Simian
Gateway is installed on the same machine as Simian Pro.

•

Voice Track Save Path – This is the folder that new Remote Voice Track audio files are saved to.
The default location is C:\BSI32\Audio, but it is possible to set this folder differently in Simian Pro’s
configuration, so check Simian Pro to determine what this folder should be set to.

•

Program Logs – The folder that Simian Pro puts it’s Program Log files. By default, this is
C:\BSI32\Logs, but can easily be changed from within Simian Pro, so check Simian’s configured
location for this path, too.

•

Import Logs – This is where Simian looks for import logs generated by third party applications.
The default path is C:\BSI32\Import. As with the above two paths, this one can be changed from
the default, so mimic the path you’ve configured in Simian.

•

Voice Track Intro/Segue Save Location – When Simian Gateway creates intro and segue cuts for
the Remote Voice Track Editor, it will save these cuts into the directory selected here. It is
important to NOT select a folder monitored by Simian/Sound Hound, since these files won’t want to
be referenced for on-air play.

Click the Done button now, since the Simian Gateway Program Options are now set.
Now it’s time to configure the connection settings. If the Simian Gateway is already attempting to accept
connections, you’ll see a button in the upper right corner of the main user interface (figure 0.2) that says
“Stop Server”. If you see this “Stop Server” button, click on it so that all connections are closed and the
connection configuration fields on the left side are made available for editing.
If you’ve installed the Simian Gateway application on the same system as your Simian Pro installation,
enter 127.0.0.1 into the Host IP Address field (that is the loop-back IP address). Since we configured
the Simian Pro host to be expecting our Simian Gateway connection on port 6500 in the previous steps,
enter 6500 into the Host Port field. If you’ve installed the Simian Gateway on a different machine, enter
the IP address of the machine you’ve installed Simian Pro on.
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Leave the Host Connection Password field blank, since we didn’t add a password on the Simian Pro
host machine in the steps above.
For now, we’ll also leave the Remote Connection Password field blank, too.
We’ll leave the Remote Connection Port field at its default of 5500, and we’ll also leave the Data
Refresh Rate field at its default of “Normal”, too.
Make sure the Enable File Transfer Port option is checked, and set its port to 5501, which is the default.

Connecting the Simian Gateway to a Simian Pro Host
If you are accessing your Simian Gateway from outside your local area network (e.g. the
internet), you’ll need to configure Port Forwarding on your network’s router to allow ports
5500 and 5501 to connect to your Simian Gateway computer. If you change the data and file
transfer ports from their defaults, you will also need to set your router’s port forwarding
accordingly.
Now, if your firewall and router’s port forwarding are configured correctly, you are ready to click on the
Start Server button in the upper right. If all goes well, Simian Gateway will connect to your Simian Pro
host, and open it’s listen ports, ready for a connection from a Simian Remote client.

Connecting a Simian Remote Client to the Simian Gateway
Once your Simian Gateway
has its server running and
waiting for connections, you
are ready to connect a
Simian Remote client!
On either the Simian Remote
for PC or Simian Remote for
iPad, enter the IP address of
the machine your Simian
Gateway is running on, or if
you’ve set up port forwarding
and have an external internet
connection, enter your public
internet IP address into the
IP Address field in the
Simian Remote client.

Figure 0.4: The Simian Remote for PC client.

Since we configured Simian Gateway’s Remote Connection Port as 5500 in the steps above, enter 5500
into the Port field on the Simian Remote Client. Once you click/tap on the Connect button, the Simian
Remote client will connect to the Simian Gateway and you’ll be controlling the Simian Pro machine the
Simian Gateway is connected to.
You can now manipulate the program log, load logs, record voice tracks, adjust the mixers, and more!
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CHAPTER 1: Introduction

Figure 1.0

Welcome to the Simian Gateway / Simian Remote Client. BSI is proud to introduce you to the newest,
most powerful feature addition to the Simian product family. We’ve spent many, many hours developing
and perfecting the Simian Gateway and Simian Remote Clients so they will be as reliable and useful as is
possible.
The Simian Gateway is an application that connects to your Simian 2.2.0 Pro radio automation software
and allows either of the Simian Remote clients (PC or iPad/iOS) to connect to your studio automation
system over a TCP/IP connection. That means that you will now be able to control your on-air Simian
machine over your local network, or over the internet. That means you can control your studio anywhere
you have an internet connection!
Not only do the Simian Remote clients allow you to perform remote control of your Simian automation
system, it also gives you full Remote Voice Tracking capability. The Simian Gateway even produces
highly compressed versions of the intro and segue portions of your songs so you can fully preview the
Voice Tracks you create remotely and set the intro and segue points precisely, just as if you were in the
production studio at your facility!
We hope you enjoy your new software, and that it simplifies and takes your broadcasting experience to a
whole new level.

-The BSI Team
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Simian Gateway Features
Simian Gateway’s best features are its ease of use, advanced technology and high versatility. Let’s take a
quick look at each of these features.

Ease of Use
•

Runs on Windows XP Pro or Windows 7 Professional 32bit.

•

Creates a simple to configure conduit from Simian Remote clients to your Simian 2.2 Pro host.

•

Up to 10 concurrent Simian Remote Client connections to your Simian 2.2 Pro host.

Advanced Technology
•

Native Remote Control clients made for both PC and iPad/iOS.

•

Access your Simian 2.2 Pro host from anywhere in the world.

Versatility
•
Since there are Simian Remote clients for both PC and iPad, remote functions are available from
a simple to use iPad, or for full on remote production, the PC Simian Remote client allows you to use
audio editors such as Adobe Audition to edit your Remote Voice Tracks and use professional audio
devices such as Audio Science audio cards.
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System Requirements
Although Simian Gateway will run on a variety of PC hardware platforms (we do not impose any
restrictions) for peace of mind, we strongly suggest that you consider purchasing a fully configured
system direct from BSI that is ready to operate out of the box (we can even pre-load a Music Library from
our MusicStore for you).
This becomes even more important since most Simian Gateway installations will be on the same machine
as Simian Pro is running.
These hardware configurations have been thoroughly tested with Simian/Simian Gateway and are known
to work well when properly configured by BSI Technicians. Most ‘off-the-shelf’ PCs will require careful
configuration as Multimedia machines, rather than general office computers.
BSI systems are built using Dell computers and include a 3-year On-Site Warranty; or we can customize
a 19" Rack Mounted solution for you using branded components that we have tried and tested.
If you decide to source your own hardware from other vendors then you will be responsible for any
additional costs incurred to correctly configure your Hardware or Windows Operating System. BSI
Technical Support is limited to hardware or software that BSI has supplied and reserves the right to
charge for configuration of third-party hardware / software that has been purchased elsewhere.

Our recommended platform is:
•

•
•
•
•
•
•
•
•

Dell Optiplex GX780 Mid-Tower Computer configured with an Operating System hard drive and a
large storage hard drive dedicated to audio files. (A 250Gb hard drive will store 5,000+ songs in
Linear PCM format. We do not advise monitoring more audio files than this at any one given
time.)
Intel Core2 Duo 2.4GHz or better
Minimum 1GB RAM (2GB or more recommended)
Windows XP Professional with SP3 or Windows 7 Professional 32bit (not 64bit)
Professional AudioScience Audio Card with four playback devices and hardware mixer controls
and metering - plus decoding of MPEG Layer 2, or MP3 audio on the audio card. We publish the
latest tested drivers on our web site.
17" or larger monitor running at 1024 x 768 or higher resolution (1280x1024 4:3 ratio or 1600x900
16:9 ratio or higher recommended)
Optional dual-output video card
Optional touch-screen
Optimized for multi-media play out by BSI technicians, rather than ‘appearance’ or office
applications. BSI Technical Support does not cover the cost of configuring computer systems or
other hardware not purchased by BSI.

Although Simian with Simian Gateway will run on lesser configurations, this is known be a good, stable
platform that will run for extended periods of time. Please check with BSI Sales for latest model
specifications. We do not recommend running Simian or Simian Gateway on any server based
operating System, including Windows 2003 or 2008, nor do we recommend or support 64bit
operating systems.
If you are sourcing your own computers & hardware, please ensure that all the hardware is fully
compatible with the motherboard - and pay particular attention to memory and cooling.
We have put together a list of some of the major pitfalls to avoid:
•
•
•
•
•

Any server based operating system (including Windows 2003 or 2008)
Windows Vista (any type) is not supported.
Any 64bit operating system.
Celeron or AMD Processors – we prefer Genuine Intel (Core 2 Duo, Core i or Xeon) CPUs
Non-Intel Chipsets (these have all proved troublesome in the past)

(Continued on next page)
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•

Software RAID / SCSI / Emulated Drives - use PATA & SATA drives and hardware RAIDs when
necessary.

•
•
•

'Cheap' Memory - make sure you use a brand recommended by your motherboard manufacturer.
Flimsy, thin cases with little RF shielding
Consumer Grade Audio Cards (these almost always lack the features required for some of
Simian's advanced operations and virtually none provide audio level metering or 100%
compatible Windows Mixer control).

In general, we also recommend that for music-on-hard-drive stations, two PCs be used... one for the On
Air Studio and the other for Production. While it's fine to do log-building and other basic Simian functions
on the air machine, it is usually better to edit music files and do other resource-consuming tasks on a
computer that isn’t actually broadcasting.

Contact Us:
Home Page:

http://www.bsiusa.com

Support Page:

http://support.bsiusa.com

Info email:

info@bsiusa.com

The front desk:

(541) 338-8588

Sales phone:

1-888-274-8721

Tech Support phone:

(541) 342-5250

Validation Codes:

http://www.bsiusa.com/codes/

____________________________________________________________________________________
Page 11

____________________________________________________________________________________

Chapter 2: General Pre-Setup Information
This section is intended to give you all of the information that you need before you set up Simian
Gateway/Remote. It will cover a variety of “Gotchas” and other issues that will make the whole process go
much more smoothly.

Windows Issues
It has been said that the main strength of Simian is that it runs in Windows, just like any other application.
It has also been said that the main weakness of Simian is that it runs in Windows, just like any other
application. Simian is easy to use, and the interface has been designed to operate in ways that “radio
people” will find familiar. However, when you make the decision to run your radio station on a computer, it
becomes important that the people who set up and maintain that computer have an appropriate level of
knowledge. It’s usually pretty easy for the DJ’s and operators to learn enough to operate Simian with a
minimum of computer knowledge. However, just like you need a knowledgeable radio engineer to handle
all of the electronics involved in this industry, you’ll need a knowledgeable computer technician to handle
the computers that have become invaluable to this industry.
®

Which flavor of Windows is the best for Simian? There are a number of considerations when picking an
operating system. To make things simple, we recommend Windows XP Pro with Service Pack 3, or
Windows 7 Professional 32bit, as they have been tested by BSI and found to be stable and can run
unattended without a reboot for longer periods of time. We do not recommend or support any
Home/limited versions, or Ultimate/advanced versions of Windows for use with Simian as they either don’t
have full network functionality or they load on extra non-essential UI graphics functions. BSI also does
not recommend or support any server or advanced server flavors of Windows.

PC Management
Organizing your files well can make or break your success with Simian Gateway. Here are some of the
most important considerations:
You have complete control over where you put any files on your computer. In Simian on the Paths tab
under Tools/Program Options you can completely control where Simian looks for the files that it needs
and writes the files that it creates. Simian Gateway also needs access to the same paths, so configuring
the locations of your audio paths is very important. We only recommend storing your audio files on a
hard drive local to your on-air Simian computer.
Design your maintenance schedule now. It is important to have a schedule for rebooting, running
scandisk, and defragmenting your hard drive. These operations take much less time if they are performed
regularly.
Do not run antivirus software on your air machine. This is very important because in some situations
antivirus software can cause audio break-up on-air. Our recommendation is to install your choice of
antivirus applications on your production machine and run it, on a scheduled basis, from across the
network. This leaves the on-air PC without the performance hit and file availability issues caused by
antivirus software constantly scanning files. If you do need to run antivirus on your on-air or Simian
Gateway computer(s), we recommend adding Simian.exe, SimianGateway.exe, SimianRemote.exe, and
SGFileConvert.exe to your antivirus’ executable scan exclude list, and add .wav, .mp3 file types and your
audio directories to the file scan exclude list as well.
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Your PC as Broadcast Equipment
Computers are often viewed as isolated devices much like any office machine, in that they can be
protected against power transients by a simple protected power strip. However, when you make the
commitment to install Simian and your entire library of music, commercials and station production
packages, your computer suddenly becomes a major piece of critical broadcast equipment.
Normally, broadcast equipment is mounted in grounded metal racks, and the individual devices that sit on
the rack are still separately bonded to a master station ground. This should also be done with the
computers and any other computer-connected equipment. Since a typical computer does not usually
have a specified bonding connection, you or your engineer should look for a convenient screw near the
power supply that is firmly screwed into the metal chassis. A # 14 or larger wire should be run from there
to the nearest equipment bonding (grounding) point.
You'll also want to use protected power strips to further isolate your system from interference or electrical
problems. These can also protect external connections like the telephone line that is connected to your
modem. By far, the best means of overall protection against serious electrical problems is to use an uninterruptible power supply (UPS). The proper type to use is the kind that continuously charges a battery.
The battery then operates a power converter to provide power to the protected load (the computer and its
equipment). Some UPS devices use fast switching to transfer the load from AC mains to converted
battery power and therefore do not provide as much protection.
Another extremely important issue is adequate cooling and freedom of access. A reasonably dust free
environment, off the floor with good air circulation is what you should seek. Remember as well, that in
time of emergency or when certain support questions need to be answered, you may be asked to check
the connections on the back of the machine. A good installation requires accessibility.
If you are in a building with the broadcast transmitter locally installed, you should consult with your
engineer about possible ‘special’ protection that may be needed. This may include shielded network
cables, choke protected telephone lines, ferrite beads on Trigger wires, physical screening or other
specialized practices. Care should also be exercised with wire runs. For example, network and telephone
cables should be run away from AC wiring. All audio wiring should be shielded and the shield
appropriately grounded.
These simple procedures will not only make your station more reliable, but can save you time and money
spent troubleshooting "ghost problems".
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Why Use Professional Sound Cards?
Professional Audio Cards are the most important investment that you can make to transform your high
quality PC into a professional audio device. Professional audio cards provide the highest possible audio
quality from your PC. Think of all of the efforts of all of the people in your organization, from the GM, to
your talent, to your sales people… All of the efforts of all of these people flow through that one audio
device. This alone is a great reason to step up to professional equipment. Quality audio devices also
provide the functionality that you need to make your station sound the best! Here are a few examples of
the types of features available with professional grade audio devices:
Multiple audio devices provide true overlap. Many single professional grade audio devices can perform
triple overlap playback all by themselves!
Record while you’re playing back. You can play back, record, or do both at once. With many of these
cards you can record Rush Limbaugh while doing triple overlap. Try that on a consumer grade card.
Decompress and play back files with very little strain on your computer’s processor. That’s right, on-board
decompression takes over the load so that your processor is free to handle other automation tasks.
It all boils down to one simple fact. You could run your radio station with that “pro” soundboard from Radio
Shack, but you don’t. So why run your million-dollar radio station with a consumer grade sound card?

Production Issues
While Simian can be run on the air while you’re doing production work, we cannot guarantee that the
production features will not slow down the computer and affect on-air playback. Look at it this way; A few
years ago it was not uncommon for a radio station to pay $3000 for a single cart machine. A production
computer with a pro sound card can cost as little as $2000, and you can run Simian in Production Mode,
which is much less expensive than Full Mode. Do the right thing for your business and your employees…
Set up a production machine. You’ll thank yourself later. Simian Pro 2.2 does have the ability to connect
to its own Simian Gateway, so you could have a separate Simian Remote connection that allows you to
remote control your Production machine, too.

Choosing Audio File Formats
One of the most common questions people ask when they’re setting up Simian Gateway is “What audio
file format should I use?”. Unfortunately, the answer from Technical Support is that there is no single
“right” file format. The reality is that you’ll need to do some research. In the interest of making this
question a little less daunting, we’ve gathered the information that you’ll need to make an informed
decision regarding your choice of file format.

Considerations
Simian itself handles four main formats of audio, PCM Wave, CBR MP3, Mpeg 2, and ADPCM. Because
the Simian Gateway has to interface with other target platforms (e.g. PC and iPad/iOS), it is more limited
in what audio formats can be used. This means that Simian itself is more limited in what formats are
allowable in conjunction with the Simian Gateway/Remote.
Simian Gateway/Remote requires that your audio (at least the audio used for Remote Voice Tracking) be
in either PCM Wave 16bit or CBR MP3 formats. This is because the Simian Gateway creates highly
compressed intro and segue cuts of your audio files used for Remote Voice Tracking. Only PCM Wave
and MP3 files can be efficiently trimmed and recompressed, and all the target platforms that run the
Simian Remote client support.
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Chapter 3: Installation
Before You Install Simian Gateway:
Verify that your computer is running properly and that it is properly connected to your network. A machine
that is not running properly will not run Simian or the Simian Gateway properly. Similarly, a machine that’s
having problems communicating across a network will not allow Simian Remote Clients to connect to the
Simian Gateway.
Verify that all your peripherals are installed and configured in accordance with the manufacturer's
specifications. Peripherals are any devices that attach to the computer and add functionality. Typical
peripherals for a Simian machine are trigger/relay devices and professional quality sound cards.
Install Simian Gateway using the full installation of the newest version (available for free download on our
support website and on CD-ROM for a nominal fee) then restart your computer.
Remember that Simian Gateway does not control the actual audio playback functions of your machine,
but rather connects to Simian Pro, which directs the Windows audio subsystem. Therefore, if your Simian
machine cannot play audio in the Windows Sound Recorder, you won’t be able to play it in Simian.
Windows Media Player is not a valid test for this subsystem, as it can use DirectSound to bypass certain
functions that Simian needs to control pro audio cards.
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Installing Simian Gateway
Considerations
Installing Simian Gateway is an easy task, and to make it easier, we'd like to point out a few things that
you should take into consideration before installing the software.
1. Do you have a properly working network card installed in your computer? Simian Gateway will not
run properly without a working Ethernet device.
2. Does your computer meet or exceed our Recommended System Requirements? Not sure?
Check out Chapter 1.
If both of these items are true, then it's time for us to install Simian Gateway. Simian Gateway installation
is performed in several parts:

Part 1: Shut Down Unneeded Processes
Windows 2000/XP Pro/7 Pro 32bit
1. Shut down all items running on your Task Bar and System Tray.
2. Move on to Part 2.
Part 2: The Sentinel Protection Driver
If you are installing Simian Gateway on a machine that already has Simian Pro installed, you
will most likely already have the Sentinel Protection Driver installed. In that case, you can
skip Part 2-5 of this section.
Simian Gateway’s Validation Process utilizes a USB Hardware Key
(shown left) which requires the ‘Sentinel Protection’ Windows Driver.
You should always ensure that you have the latest BSI-tested version of
this driver, available on our ‘Latest Drivers’ page, or from the BSI Install
CD when purchasing a new product – and that is it correctly
configured.

Figure 3.1

The following instructions are a step-by-step walk through of how to
install and configure the Driver that will only take a few minutes. (This
driver is NOT provided with the Simian Gateway demo download, nor
required for the demo version).

Part 3: Installing from the BSI Install CD
The BSI Install CD should automatically launch
when inserted into your CD-ROM drive. If you have
disabled that feature, double-click the Install.exe
file on the CD.
You will then see the Application Selection window
(see below). Choose “Sentinel Protection Installer –
for BSI Dongles” (the first option from the dropdown
list) and click Install.

Figure 3.2
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Part 4: Download the Driver
If you do not have your BSI Install CD available, the latest BSI-tested version of the driver is also
available for download on the ‘Drivers’ page at http://www.bsiusa.com
Save the installation file to your hard-drive into a known directory (the desktop is the easiest). To install,
double-click the .exe file.
Note: The following images may change as drivers / installers are updated and depend on the Operating
System installed on your computer.

Part 5: Installing the Sentinel Protection Installer
After starting the Sentinel Protection Installer from the BSI Install CD, or by downloading from the internet,
you can follow the on-screen prompts as shown below to complete the installation.

Figure 3.3

Figure 3.4

Figure 3.5

Figure 3.6

Click Next >

Read & Accept, then click Next >

____________________________________________________________________________________
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Figure 3.7

Figure 3.8

Select Custom and then click Next >

Disable ‘Server’ option and Click Next >

Figure 3.9

Figure 3.10

Click Install

Click Next > when available

Click Finish when the InstallShield Wizard has completed the task (see below).

Windows XP SP2 users only
If you did not select the ‘Custom’ option, or
allowed the ‘Sentinel Protection Server’ to be
installed, then customers using Windows XP
Professional will usually see an additional
“Windows XP detected!” window.
It is recommended to choose “No” at this prompt
to continue because the BSI hardware key does
not support the ‘Protection Server’ features of the
driver.
The Sentinel Protection Installer will then finish
copying files and you can click Finish when the
InstallShield Wizard has Completed.
Figure 3.11
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If you are including Simian Gateway in your Windows Startup folder so that it automatically runs when
Windows is booted, it is recommended to change the Start-up Type of the Sentinel driver from
Automatic to Boot. (Otherwise, Windows waits until the user interface is loaded).

Figure 3.12

Figure 3.13

Right-Click “Computer” / “My Computer” and
choose Manage. Highlight Device Manager and
from the View menu, select “Show hidden
devices.”

Expand the Non-Plug and Play Drivers section
and search for “Sentinel.”
Right-Click it and
choose Properties. (If you do not find an icon for
Sentinel, reboot and repeat).
Go to the Driver tab and from the Startup Type
choose Boot from the drop-down list and click OK.
You can now close the Computer Management
window and it is recommended that you restart
your computer.

Figure 3.14

Part 6: Install Simian Gateway
You can install Simian Gateway from the BSI CD as part of installing Simian Pro, or from a downloaded
Simian Pro installer file. Both the CD and the download contain the same SimianPro_Setup.exe file.
1. Start the Installer
•

If you downloaded the SimianPro_Setup.exe file, double-click it.

•

If you are using the BSI CD, simply put it in your CD ROM, wait for the BSI window to show
up on your desktop, then select Simian Pro and start the installation.

____________________________________________________________________________________
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2. Click Next and you'll get to the License Agreement screen. You'll have to click the radio button
that says "I accept the terms in the license agreement", and then click Next to continue with the
installation.
3. In the Customer Information screen, you will be asked for your User Name and Organization.
Just enter your information and click Next.
4. The Setup Type screen will allow you to select between Full, Update, or WaveStation setup.
•

Full Installation will install Simian and wipe out any settings from previous installs. Use this
setting for a new installation of Simian.

•

Update is used for upgrading Simian. It will preserve Program Options and Hardware
Options settings from a previous Simian installation.

•

WaveStation is for our customers who are migrating from the WaveStation product. This
installation will seek out the old WaveStation Program Options and migrate them to Simian
automatically.

Click Next
5. The Select Options screen is where you select to install Simian Gateway. Click on the Simian
Gateway check box and click Next.
6. The Shortcut Folder screen allows you to change the name of the folder in which Simian will
show up under Start/Programs. Once you have the name the way you'd like it, click Next.
7. The Select Options screen allows you to choose to place an icon in the Quick Launch Bar (for
Windows XP), and it also allows you to place Simian Pro and/or Simian Gateway in your system’s
Startup group, which means that the applications you choose will automatically start when
Windows starts. If you are installing Simian Gateway on a machine that is also running Simian
Pro, it is recommended to enable both options. If you are installing Simian Gateway on a system
that will run Simian Gateway stand-alone, uncheck the option for Simian, but enable the option for
Simian Gateway. Click Next to continue.
8. The Ready to Install screen allows you to review your installation choices and start the
installation. Make sure that you like what you see here and click Next.
9. The Windows installer will automatically install Simian and bring you to the final screen, which will
let you know that installation has completed successfully. Just click Finish to finish the
installation.

Part 7: Restarting Your Computer
Once you have finished the installation process, restart your computer to make sure that everything
registers properly. This is not necessary, but is always good practice whenever you install software of any
kind.
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Validating Simian Gateway
Simian Gateway is protected by security hardware and validation codes that allow for limited testing of the
software prior to purchase. These security measures are disabled when you purchase and validate the
software. In demonstration mode, Simian Gateway will run for 10 minutes and then shut down
automatically. This is designed to let you download and try out Simian Gateway before purchase.
When you purchase Simian Gateway, you are shipped
a small hardware key (either as part of Simian Pro, or a
separate key if you plan to install Simian Gateway on a
stand-alone machine). To validate Simian Gateway,
simply plug the hardware key in one of your computer's
USB ports. When the hardware key is installed, Simian
Gateway will need a validation code. You'll find it on a
piece of paper in the folder included with your hardware
key. Once you've located your validation key, simply
go to Help/Register and fill in the required information.
It's really that simple. Plug in the hardware key, then go
to Register on the Help menu and enter the Validation
Code and your information, and Simian Gateway is
ready to go.
Simian Gateway can be validated for two different
modes. These different modes correspond to the two
different types of licenses available. Let's take a look:
•

•

Full Mode allows you to connect to a single
copy of Simian Pro on the air, or a single
instance of Production Mode on one computer.

Figure 3.15

Multisession Mode allows you to run up to nine instances of Simian Gateway on one computer,
allowing you to connect to up to nine production or on-air Simian Pro systems (one instance of
Simian Gateway connects to each Simian Pro instance).

If you lose your validation
code, you'll need to visit the
Validation Codes page of
www.bsiusa.com and enter
your:
•

Customer ID number

•

Version number

•

Serial Number

•

The name under
which Simian was
purchased

We normally return validation
codes within 1 hour during
business hours. The required
information can always be
found by going to the Help
menu and choosing Register.

Figure 3.16
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Chapter 4: Getting to Know Simian Gateway
Learning the Simian Gateway User Interface

Figure 4.1

When Simian Gateway opens, you can see the main window – If the Simian Gateway user interface
shown at above does not appear, look in your system tray for the
icon and click on it. The user
interface should then appear.
The Simian Gateway interface has a lot of the familiar Windows® features such as a Title Bar and menus
across the top.
The middle area, contains areas to enter information about your Simian Pro host machine, how you want
your Simian Remote clients to be able to connect to the Simian Gateway, and statistics about who is
connected and status and/or error messages.
We recommend taking the time to familiarize yourself with the interface. The following section will take
you through not only the user interface elements, but also the options in each menu and what they do.
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Menus
The Simian Gateway only contains two main menus, the Options menu, which takes you directly to the
Simian Gateway Program Options window, and the Help menu, which contains several options that give
you information about the application (including a help file version of this manual) and registration of
Simian Gateway.
The following list is a breakdown of each menu and their selections:
•

Options – Clicking this menu will display the Simian Gateway Program Options window. This is
where you configure the locations of required directories, the format and quality of the intro/segue
encoder, and more. This window is covered in more detail later in this section.

•

Help – This menu contains several selections, they are:

•

o

Register – This selection will display the Simian Gateway Registration window. To
register Simian Gateway, select this option and enter the pertinent information. For a
more in depth walk through of how to register Simian Gateway, see the Validating Simian
Gateway section of this manual.

o

Help Contents – Choosing this selection will open the Simian Gateway help file and set
it to view its Contents tab.

o

Help Index – Choosing this selection will open the Simian Gateway help file and set it to
view its Index tab.

o

Search Help – Choosing this selection will open the Simian Gateway help file and set it
to view its Search tab.

o

About – Selecting this menu option will cause a window to pop up which displays
information about your current Simian Gateway installation, such as the version number
and the current registration type.

Connection Status – This selection is not a menu per se, but it is in the menu bar. This text
section displays the current connection status. If no Simian Remote clients are connected, it will
display weather it is waiting for remote connections, or if remote clients are connected, it will tell
you how many there are.

Start / Stop Server Button
This button, shown in the upper right corner of the user interface (see figure 4.1) starts or stops the
TCP/IP connections, both to the Simian Pro host, and the incoming ports for Simian Remote clients to
connect to.
If the server is currently stopped, the button’s title will display “Start Server”, and clicking on it will cause
Simian Gateway to connect to Simian Pro, and open its ports to allow Simian Remote clients to connect.
If the server is currently running, the button’s title will display “Stop Server”. If remote clients are currently
connected, clicking on the button will disconnect them. Clicking on it will also cause the Simian Gateway
to disconnect from the Simian Pro host.
While Simian Gateway’s server is active, all the Simian Connection Settings and Remote Connection
Settings fields will be locked out since they can’t be edited while the server is active. To edit the settings,
make sure the server is inactive (the Start/Stop Server button’s title will say “Start Server”).
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Simian Connection Settings
The Simian Connection Settings section on the left side of the main user
interface is the location you enter the IP address and port that your
Simian Pro host system has made available for Simian Gateway
connections. If you haven’t set up Simian Pro’s Remote Gateway
Connection settings in Simian Pro’s Hardware Options, you need to do
that first. If you set up a connection password in Simian Pro, you’ll enter
that in the Host Connection Password field as well. The Password in this
Figure 4.2
field is what the Simian Gateway uses to connect to the Simian Pro host,
not the password remote clients will use to connect to the Simian Gateway.
If you are running Simian Gateway on the same computer as you are running Simian Pro, you can use
the loop-back IP address (127.0.0.1) rather than the actual IP address of the system on the network,
otherwise, you will need to determine the IP address of the system Simian Pro is running on and enter
that into the Host IP Address field. The Host Port is determined by your configuration in Simian Pro, but
Simian Pro defaults to port 6500.

Remote Connection Settings
The settings in this section of the user interface determine how Simian
Remote clients will connect. The Remote Connection Password is the
password remote users will need to enter to be able to log in to the Simian
Gateway.
The Remote Connection Port is the main TCP/IP port used for data
communications between the Simian Gateway and the remote clients. This
is the port number remote users will enter into the remote client (along with
the IP address to access the Simian Gateway) when they connect to the
Simian Gateway.
The Data Refresh Rate dropdown determines the update cycle time for
playback deck information, such as position and VU meters. That
information is pushed to the remote client(s) constantly, and the setting of
this dropdown determines how often that cycle is. The higher the Data
Refresh Rate is, the more data is sent, so if your remote clients will connect Figure 4.3
over a data metered contract internet connection (such as an over-the-air 3G or 4G connection), it is best
to keep this setting lower rather than at the faster speeds available. If they are connecting over an
unlimited high-speed internet connection, you can set this dropdown to as fast of a setting as you want (or
your connection speed will handle).
The File Transfer Port field determines the TCP/IP port that audio files will be transferred over for Remote
Voice Tracking, both uploading intro/segue cuts to remote clients, and for remote clients to upload
completed Voice Tracks and audio files. The File Transfer Port can be disabled if you do not want remote
users to be able to upload or download audio files into Simian.
The Filter Remote IP Address function allows you to only allow specific IP addresses to log into the
Simian Gateway. Keep in mind that the filter uses exact match IP addresses, no wild cards are available,
so if your remote clients aren’t at machines (or internet connections) with a static IP address and their IP
address changes, they could be locked out unintentionally until the filters are manually updated by you.
In other words, use this function with care.
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Current Remote Socket Status
This section in the upper left of the user interface displays
the connection state statistics for the Simian Gateway’s
listen socket for remote clients.
Figure 4.4

Connected Remote Clients
The Connected Remote Clients list, in the upper middle of
the user interface, lists each remote client’s IP address,
software version, and platform (PC, iPad, etc.).
Figure 4.5

Current Host Connection Socket Status
This section, on the upper left of the user interface,
displays information about the Simian Gateway’s
connection to your Simian Pro host.
Figure 4.6

Status Messages
The Status Messages list, the large list in the
bottom half of the main user interface, displays any
status or error messages, each with a date and
time stamp. Each time a remote client connects, or
the Simian Gateway server is started or stopped, or
a connection error occurs, the message will be
added to this list. You can clear the list by doubleclicking on any of the status messages.

Figure 4.7

Program Options Window
Simian Gateway’s Program
Options window is accessed by
clicking on the Options menu
option at the top of the main
user interface.
The Paths section, at the top
of
the
Simian
Gateway
Program Options window, is
used to determine where
Simian Gateway will look for
important file types.
The First path is the Audio
Database path. This is the
audio.mdb
file
that
SoundHound creates for your
Simian Pro application.

Figure 4.8
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Simian Gateway uses Simian Pro’s audio.mdb file to get your audio library information so remote clients
can get the listing of what audio files are available on the Simian Pro machine. If you are running Simian
Gateway on the same system as Simian Pro, this file is found in C:\BSI32\Audio.mdb. If you are running
Simian Gateway on a separate system, you will need to set up file sharing on your Simian Pro system so
that Simian Gateway can access it across your local area network (keep in mind that this kind of setup
can greatly slow down access to this file).
The Voice Track Save Path determines where Simian Gateway will save Remote Voice Tracks when
they are uploaded from Simian Remote clients. This path needs to be a path that is monitored by your
Simian Pro system’s Sound Hound.
The Program Logs path is the directory your Simian Pro system stores its program logs. This path is
used to give remote clients a file list of the available program logs for loading or saving.
Similarly, the Import Logs path is the directory your Simian Pro system is set to look for import logs. This
information is used by Simian Remote clients to allow remote log importing.
The Simian Gateway uses the Voice Track Intro/Segue Save Location path to store and cache the intro
and segue cuts it creates when a Simian Remote user loads the Remote Voice Track editor with the intro
and segue cuts. This folder should NOT be monitored by SoundHound on your Simian Pro system, since
the intro and segue cuts are not used for on-air play. It is also important to make sure that the directory
you choose for this function has plenty of free space, since the intro and segue cuts are permanently
stored in this directory (until you manually delete them) so that the Simian Gateway doesn’t have to recreate intro or segue cuts for songs it made them for in the past, it can just re-use the cut it made
previously.
The Voice Track Cut Encoding section determines the quality, length, and processor priority that will be
used to create intro and segue cuts when Simian Remote users load the Remote Voice Track Editor.
The Codec dropdown allows you to select a suitable ACM codec (the Windows multimedia system
codecs that are available to all applications) that supports CBR MP3 files.
BSI recommends the CyberLink ACM MP3 codec (available through BSI Sales for a small
fee) for commercial stations. The LAME ACM MP3 codec has also been extensively tested,
but is an open source product, and licensed only for non-commercial usage.
The Format dropdown lists all the available formats for the selected codec type. BSI recommends lower
bit-rate mono MP3 formats, such as 64kbps or 96kbps, CBR, mono, so that users can get a reasonable
quality sounding intro/segue cut while keeping file size down so that their download times are kept to a
minimum. This setting is completely up to your taste, though, so if you want a better quality intro/segue
cut for creating your Remote Voice Tracks, and longer download times are acceptable to you, you can set
the format to any CBR MP3 format you like.
The Encoding Process Priority dropdown determines what CPU priority setting the Simian Gateway File
Converter will use while creating intro/segue cuts of your songs when they are requested by Simian
Remote clients when they are creating Remote Voice Tracks. If you are running Simian Gateway on the
same machine as you are running Simian Pro on the air, and you only have a single processor (and no
hyper threading), it is recommended to keep this setting to normal or low. If you have a multi-core system
and/or hyper threading, or you are running Simian Gateway on a separate system than Simian Pro is
running on, you can set this to normal or mid. This setting is determined by the horse power of your
system, though, so some experimentation on your part may be in order if you don’t want to leave it set at
the “normal” setting. That being said, BSI recommends this setting be left at “normal” for non-advanced
users that don’t want to tinker.
The Intro/Segue Pre/Post Roll Time determines the overall length the intro and segue files will be.
When Simian Gateway creates an intro or segue cut, it analyzes the audio file to determine the intro point
or segue point of the audio, as set in the audio file’s meta-data, then adds the length set in this dropdown
to determine the length the intro/segue cut will be trimmed to. For instance, if you have an audio file with
the intro point set at 12.5 seconds, and the Intro/Segue Pre/Post Roll Time is set to 15000ms, the intro
file Simian Gateway would create would be 27.5 seconds long.
____________________________________________________________________________________
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Chapter 5: Operation
Once you have configured Simian Gateway to connect to your Simian Pro automation system, configured
your Simian Remote connection settings, and configured your router for port forwarding/NAT, there really
isn’t much to the operation of Simian Gateway.
To run Simian Gateway, all you need to do is open your Simian Pro automation software, then open
Simian Gateway and start the server. Once the server is running, the Simian Gateway is ready to accept
connections from Simian Remote clients.
It really is as simple as that!

____________________________________________________________________________________
Page 27

____________________________________________________________________________________

Chapter 6: Troubleshooting
Optimizing Windows®
When using Windows, there is little that you can do to optimize the actual Microsoft release of the
operating system. Unfortunately many computer manufacturers decide that the original version of
Windows isn't good enough, and they add programs that run all of the time… Whether you want them to
or not. These types of programs can affect Simian's on-air performance. Always try to use the cleanest
Windows installation possible.
Also, some normal common-sense computer practices need to be avoided for the on-air Simian
computer. Try to avoid programs that constantly run in the background, such as the Task Scheduler or
any Anti-Virus programs on your on-air machine unless it’s one that we’ve tested and can mask our
system and audio files. Otherwise, these background programs can cause many problems such as audio
skipping, system lock-ups and program crashes when used in conjunction with Simian. Any situation
where the automatic protection features of an antiviral program are constantly scanning files is bad news
for your air machine.
Try to avoid hard drive Power Management functions. These settings are in your BIOS, as well as in your
Control Panel/Power Management folder. You may need to call the technical support section of your
computer manufacturer to assist you with this. In the Control Panel, make your Settings for Always On
power scheme say Never for hard drives.
Because Simian is graphics-intensive, it’s best to minimize the fancy Windows tricks like mouse trails,
icon animations, etc. Do this by going to the Control Panel/Display/Effects tab and disabling Show
window contents while dragging and Animate windows, menus and lists.
Turn off Windows Sounds. In Control Panel/Sounds/Schemes, select No Sounds. This is important so
you don’t get unwanted beeps and tinkling from Windows on the air!
Don’t use wallpaper. Every time you move something on the desktop, Windows has to redraw every pixel
of the wallpaper graphic. This surprisingly simple thing can really slow your system down. Right-click
your desktop, choose properties, then (None) for Wallpaper.

Installation Problems
If an installation fails, or Simian will not launch after a power failure or similar traumatic experience,
please call our Technical Support Team. They will be more than happy to lend you a hand. The following
clean reinstallation instructions are for the computer expert who knows that a clean reinstallation is
needed, or as a guide for when Tech Support says it's time to clean reinstall.
Reinstallation should be one of the last troubleshooting steps, not the first. If you cleanly reinstall Simian,
you will have to reconfigure most of the options in SoundHound and Simian. You will need to re-enter
your validation code after a clean reinstall.

Do not attempt the following step unless you are a knowledgeable computer expert. Always
backup your Registry files before attempting to edit the registry.
Instructions:
1. Download the newest full install of Simian.
2. Shut down any applications that are running on the Taskbar, including Simian.
3. Shut down SoundHound manually if it is still running.
4. Remove Simian from the Add & Remove Programs Control Panel.
5. Verify that the following files have been removed from the C:\windows\system folder (Win98) or
the C:\winnt\system32 folder (Win 2000/XP):
____________________________________________________________________________________
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•

AcmCvt32.dll

•

BsiGeode.dll

•

BsiNet32.dll

•

BsiUtl232.dll

•

BsiUtl32.dll

•

Extract32.dll

•

HolyGrl32.dll

•

mmbsi32.dll

•

Sx32w.dll

•

wavinfo32.dll

6. Verify that the following files have been removed from the C:\bsi32 folder:
•

Simian.exe

•

SimianGateway.exe

•

SGFileConvert.exe

•

S

•

ndhound.exe

•

audio.mdb

7. Search
the
Windows
Registry for the word
“Simian” (no quotes), and
remove any Keys (not just
Values) that refer to it.
Make sure to search
repeatedly (F3) until you
see a message that says
“Finished
searching
through the registry”:

Figure 5.1

8. Close the Registry Editor and restart your computer.
9. Shut down any TSR’s other than Explorer and Systray.
10. Install the newest version of Simian.
11. Restart your computer.
12. Launch Simian.
13. Make sure your dongle is installed and enter your Validation Code.
14. Reconfigure Simian and SoundHound.
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Random Problems
Errors that seem to occur sporadically and that are difficult to reproduce may indicate a DLL conflict or a
corrupt audio database (audio.mdb). Try deleting your audio.mdb and letting SoundHound recreate it.
Also, verify that you have only one copy of each of the following DLLs and that they are all in your
c:\Windows\System (C:\WINNT\System32 for NT based machines) folder and no other.
•

AcmCvt32.dll

•

BsiGeode.dll

•

BsiNet32.dll

•

BsiUtl232.dll

•

BsiUtl32.dll

•

Extract32.dll

•

HolyGrl32.dll

•

mmbsi32.dll

•

MSWINSCK.ocx

•

Sx32w.dll

•

wavinfo32.dll

Each computer with BSI software installed should have only one copy of these files. They should all be in
the c:\windows\system folder (C:\winnt\system32 on Windows 2000). Use the Find Files feature under
the Start button to confirm that you have only one copy of the files and that they are in the right place.
Using long file names for your audio files can also lead to errors that appear random. Make sure you are
not using long file names or long folder names (keep with the 8.3 file naming convention). In addition,
make sure that you do not have apostrophes or other special characters in these names.
Finally, random errors can be caused by conflicting hardware. Have your PC technician check your
device manager for hardware and IRQ conflicts.
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Technical Support
BSI offers different Tech Care Plans to reflect the different levels of technical support required by
individual users.
Simian Lite does not include any support plan, but 6 months of Web-Based Support Tickets are included
from the date of purchase.
Everyone has access to our web based user forum & knowledge base. Customers can choose between
our GOLD and PLATINUM Tech Care Plans for additional support.
PLATINUM

Gold

60 minute
response1

Same day
response1

FREE

24/7 Off-Air Emergency
Telephone Support
Page our on-call engineer and receive a
rapid response in under 60 minutes1

Premium Telephone Support
Obtain a prompt telephone response2
normal weekdays between 6am and
6pm Pacific from our own Tech Support
staff for all BSI supplied hardware and
software. (We do not use third-party or
overseas call centers).

Web-Based Support Tickets
to urgent Support Tickets submitted
normal weekdays between 6am and
6pm Pacific

Remote Login Support
Free remote PC Login for BSI software
related tech support issues

FREE BSI Software Upgrade
Protection
Free upgrades for each purchased BSI
software for which a Tech Care Plan
applies

FREE Simian Prod to Air Mode
Upgrade3
Activates main Play Decks on Prod
Machine for backup (simulates AIR
machine)

System Check & Configuration
In the event of technical issues, we will
remotely log in and check your PC and
software configuration for any hardware
or software purchased through BSI

BSI User Forum
20,000 tips & tricks available 24/7 or
enlist the help of other BSI users

Validation Codes
Replacement validation codes for all
your purchased versions of BSI
applications.

BSI Utility & Driver Updates
Free Tested and Certified Updates
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PLATINUM Tech Care Plan - $1299 per year
All Simian Pro customers are automatically enrolled in the PLATINUM Technical Care Plan
for the first 12 months from date of purchase. The Tech Care Plan is then optional, and
renewable annually throughout the life of the software.

Gold Tech Care Plan - $999 per year
Many of the same features of the Platinum Tech Care Plan (does not include 24-hour Off-Air
Emergency support, among others, see above chart for more info) for $300 less than the
Platinum Tech Care Plan.
The Tech Care Plan is optional, and renewable annually
throughout the life of the software.

Non-Automation product support plan - $299 per year
Gold level support for our non-automation products
SkimmerPlus, and Speedy is available for $299 per year.

including

Stinger,

WaveCart,

Notes:
1Under 60 minutes is target response time for Platinum TCP, Same-Day response time for Gold TCP,
during normal business hours. Internal monitoring ensures that we work closely to achieve these targets.
2On the rare occasion that all our technicians are busy, we will provide a prompt call-back (domestic US
only) - we DO NOT leave you holding in a queue and calls are routed directly to our tech staff at our
facility in Springfield, OR. We do not use overseas call centers.
3Limit of one Prod to Air upgrade per FULL mode license purchased for the duration a
Platinum Tech Care Plan is valid. Upgrade is designed to be used for backup or training
purposes only.

A La Carte Training & Support - from $199 per incident
Customers requiring telephone support and / or additional training and who do not have a
current Tech Care Plan, or who do not have a Platinum Tech Care Plan and need assistance
outside of normal business hours, can purchase A La Carte
NOTE: purchasing A La Carte support does not qualify purchaser for free software version
upgrades.

Training Sessions
pre-booked training sessions from $99 per hour.
NOTE: purchasing A La Carte support does not qualify purchaser for free software version
upgrades.

Program Log Building - $299
Having trouble building your Program Log; need help with your Scheduled Record Events for Time
Shifting; just added a new satellite show or flipped formats and not sure what you need to do in your
Program Log?
Now, help is at hand from the experts at BSI. We'll spend time helping you create your Program Log
ensuring that it is running smoothly and that you understand what's going on!
Our custom Program Log building costs $99 per hour, with a minimum 3-hour booking.
Additional hours charged at $99 / hour.
IMPORTANT: Prices published here were effective at the time of this manual’s
original printing. Prices are subject to change at any time. For current valid
pricing, please visit http://www.bsiusa.com.
IMPORTANT: Prices published here are per machine for single users. Radio Groups
with multiple machines requiring Tech Support Plans for more than one computer
and / or users should contact BSI sales for special pricing based on the number of
computers and users to support and the level of support required.
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Technical Support or Training?
BSI has two sections designed specifically to assist you; Technical Support and Training. While they are
both here to help you out, their backgrounds and goals are a bit different. Let's take a look at each:

Tech Support
Our Technical Support department is made up of hardcore computer people who work hard to fix
problems with BSI software. They're here for you when BSI software is not functioning properly to help
you get your software (and sometimes hardware) up and running properly. These people can tweak
Simian and shuffle IRQ's with the best of them. When BSI software is broken, contact Tech Support.

Training
Our Training department is made up of Radio Engineers who work hard to help you integrate your BSI
software into your radio station. These people know about things like ferrite beads, grounding, and
scheduling software. When you need help building a Program Log, or wiring your Triggers, Contact our
Training section to set up an appointment.

Customer Assistance Contact info
Technical Support Phone Number:

(541) 342-5250

Technical Support Email:

support@bsiusa.com

Technical Support on the Web

www.bsiusa.com/support

Training Section Phone Number :

(888) 274-8721
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Appendix
Contact Information
Headquarters:

Broadcast Software International
909 International Way
Springfield, Oregon 97477
USA
Email: info@bsiusa.com

Sales:

1.888.274.8721
541.338.8588
Email: sales@bsiusa.com

Technical Support:

541.342.5250
Support Center: http://support.bsiusa.com

Training

541.338.8588

Validation Codes:

Visit http://www.bsiusa.com/codes to submit a validation code request.

Fax:

541.338.8656

Web Site:

www.bsiusa.com

Other Products From BSI and Our Partners
Music Store—BSI now offers over 45,000 songs in a wide variety of digital formats. Contact Sales for
information on titles, formats and pricing.
Natural Log—Traffic and Billing system from Natural Software. Offers traffic, billing, reporting, data
backup/restore capabilities, account receivable and payables and end of month closing features. Natural
Log can handle two stations within a single billing environment and an unlimited number of separately
billed stations.
Natural Music—Music Scheduling system from Natural Software. Gives you substantial control over
your playlist. The single keystroke interface lets you move through the program quickly and easily. You
can schedule up to 99 different music categories by day part and separation. Tempo and style
information can be used to design a unique sound for your station.
SkimmerPlus -- Easy Audio Logging and Skimmer. SkimmerPlus can record in linear PCM and
compressed audio file formats at the same time. Includes web playback module and built-in web server
for easy access to recorded audio.
Speedy—Automated CD-to-PC dubbing. The recording system automatically dubs, names and tags files
each song for you. Transfer one, several or all tracks easily and audition songs before dubbing if desired.
Stinger—Instant Audio Player that gives you fast, easy access to your sound effects, liners, beds and
bits. Up to 288 audio cuts can be instantly available for playback in Stinger and each audio cut has its
own on-screen description and button which can be color-coded. Supports drag and drop manipulation.
WaveCart—On-screen “cart machine” that displays up to ten decks audio files and giving you
instantaneous, crystal clear playback. WaveCart supports spot rotation and it can also play more than
one spot at a time.
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Vendor Contact Information
AudioScience, Inc.
Manufacturers of audio cards recommended by BSI.
Phone: 302-324-5333

Fax: 302-235-7110

www.audioscience.com

Broadcast Tools
Manufacturers of trigger and relay devices and audio switching devices used with BSI software.
Phone: 360-854-9559

Fax: 866-783-1742

www.broadcasttools.com/

Natural Broadcast Systems
Manufacturers of Natural Music and Natural Log software.
Phone: 210-349-5808

Fax: 210-344-7567

www.nat-soft.com

Legal Information
Limited Warranty
Broadcast Software International warrants that all disks provided are free from defects in material and
workmanship, assuming normal use, for a period of 15 days from the date of purchase.
Broadcast Software International warrants that the program will perform in substantial compliance with
the documentation supplied with the software product. If a significant defect in the product is found, the
Purchaser may return the product for a refund. In no event will such a refund exceed the purchase price
of the product.
EXCEPT AS PROVIDED ABOVE, BROADCAST SOFTWARE INTERNATIONAL DISCLAIMS ALL
WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH
RESPECT TO THE PRODUCT. SHOULD THE PROGRAM PROVE DEFECTIVE, THE PURCHASER
ASSUMES THE RISK OF PAYING THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR,
OR CORRECTION AND ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES. IN NO EVENT WILL
BROADCAST SOFTWARE INTERNATIONAL BE LIABLE FOR ANY DAMAGES WHATSOEVER
(INCLUDING WITHOUT LIMITATION DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS
INTERRUPTION, LOSS OF BUSINESS INFORMATION AND THE LIKE) ARISING OUT OF THE USE,
OR THE INABILITY TO USE, THIS PRODUCT EVEN IF BROADCAST SOFTWARE INTERNATIONAL
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
Possession and/or use of this product for more than 24 hours constitutes your acceptance of this
agreement and subjects you to its contents.
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GLOSSARY
ACM Codec
This is a codec (code-decode) used to encode or decode audio files which is part of the Windows
multimedia audio sub-system. Simian Gateway requires an MP3 ACM codec to create intro/segue cuts
for Remote Voice Track creation.
Adobe Audition (formerly CoolEdit)
A software application used for audio production/editing that can be launched from within Simian. It is a
digital audio recorder and editor that allows you to manipulate your audio files. It includes numerous
special effects modules and can mix up to 128 tracks together using just about any sound card.
Amplitude
Relates to sound waves. Technically, it is the difference between the highest point and zero point of a
wave. On a wave form display, a low amplitude, quiet wave would be one that would vary much less (up
and down), while a louder waveform would vary more.
AudioScience
A supplier of high quality audio cards. Most AudioScience audio cards support the features required for a
fully realized Simian system.

APP (Application)
A software program or executable. A file with an “.exe” or “.bat” extension.
Asynchronous Deck
An additional playback deck in Simian (also known as deck #4), which plays asynchronous audio events
such as those activated by a HotKey or Trigger. This deck allows you to monitor events that are not listed
as a scheduled event in the log. Display or hide the asynchronous deck using the Async menu.
Automation
The replacement of manual tasks by computerized methods.
AutoMute
A feature used in satellite automation. It mutes the mixer during WAV file playback so you don’t need to
use Relays to “kill” network audio.
AutoStep
A menu command that tells Simian to automatically continue to the next line after it has finished playing
or executing the current event creating a “stream” or “chain” of events. If AutoStep is “ON” for an event, a
"+" mark will be displayed in the “Cue” column. AutoStep can be activated by highlighting an event and
hitting the “+” key on your keyboard or by selecting the Auto Start option in the Event Builder for the
selected event.
Auxiliary
Supplementary equipment or features that provide additional capabilities to a basic system. Examples of
Auxiliary equipment in Simian are the “Triggers” or “audition” path (channel) assigned to your sound card
(audio device).
BPM (Beats Per Minute)
Beats per minute is a way of measuring a song’s tempo. It is usually based on a segment of a song and
is not necessarily the average of the entire song. To measure the BPM, open the song in Adobe
Audition. Highlight an area that has one bar, which can be just a small sample that repeats itself
throughout the music (if you looped this bar it would make a long beat -- this is how you know you have
selected a bar). Now make sure it runs smoothly, meaning it doesn't cut any part of the beat off. When
you do this go to Edit > Edit Tempo. With just one bar selected, click Extract. This will change the BPM
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box at the bottom. You just have to make sure you select the right section, which would just be one
repeating section of music throughout your audio.
Cart
A list of two or more audio events to be played in a virtual loop (AutoStart Cart), or played signally (a
Randomized Cart or a SmartCart), which are associated with a single Event name (cart number). For
example, if an advertiser had two audio segments (spots) they wanted to run alternately (in a 50/50
rotation), you would enter both “cuts” in a Simian Cart event and they would play alternately. Carts in
Simian are data lists that contain the names of WAV files, not the actual audio data. Because of this,
multiple carts can include the same audio file without taking up additional hard drive space. These files
can be recognized by the extension .KRT. For example, a cart called TEST would actually be a file
named TEST.KRT.
Category
A type specification assigned to all events in a program log. A means of grouping a collection of similar
files. 11 categories in Simian are predefined. They are App, Audio, Comment, Log, Macro, Rec1, Rec2,
Script, Text, Video and Vtrack.
Channel
A path in an audio circuit. It can refer to an incoming stream or input, an output, a recording channel or
path, playback channel, preview channel, etc.
Computer Boards (Now Measurement Computing)
A supplier of digital audio equipment, now known as Measurement Computing Corporation. BSI uses
Computer Boards as their main vendor for hardware such as the Input/Output card that lets your PC
interface with external devices such as a Satellite receiver or tape recorder.
Configuration Settings
Simian’s program options that can be modified by the user. Configuration settings tell Simian where to
look for files, what settings to turn on automatically at startup and what hardware is installed, among other
things. They are settings that vary depending on a user’s individual requirements and system.
Configuration settings are found in the Tools menu.
Cool Edit
Audio Editing software application which was sold to Adobe©. See: Adobe Audition
Crash Recovery
A Simian option that, when activated, keeps a copy of the current log in case of a power outage. The log
can be reloaded as it was last displayed before the interruption. Simian must be placed in your Windows
Startup folder and Event Logging must be ON for recovery to take place. This feature uses extra CPU
resources and is only recommended when necessary (for example, if power outages are frequent or
expected).
Cue
An indicator. In Simian, it is the column in the program log area that shows you how the event (song,
command, etc.) is going to behave when its time has come. A cue is also an indicator that tells you
where you are within a particular song. For example the “outcue” for a song would be the last few words
sung—indicating to the jock that the song is ending. To “cue up” a song means to make sure it’s properly
set before it’s aired. This requires a special “auditioning” circuit or channel on your audio card so you can
“preview” sound on one channel while another one is used for broadcasting.
Cut
A song.
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Device
A device can be part of a professional audio card (a multi-device sound card lets you playback more than
one file at a time) or it can be any machine or component that attaches to a computer, such as a printer,
disk drive, mouse, etc.
DirectSound
Microsoft Windows 98/2000/NT/XP include an audio capability called DirectSound. Simian, WaveCart
and STINGER support DirectSound, but DirectSound is very limited in its capabilities. With the exception
of STINGER, DirectSound should be used for test and demonstration purposes only. It is not stable or
efficient enough for long-term on-air or other professional use. DirectSound was developed by Microsoft
as part of its DirectX gaming technology. It is meant to allow for the playback of short overlapping, noncompressed audio files during game play. It was not designed for and is not reliable enough to use for
professional automation playback.
Dongle
A small hardware device that attaches to a computer and holds validation information. Simian cannot be
run full-time without a dongle.
Driver (Device Driver)
A file or program that allows your peripheral devices (non-essential hardware) to communicate with your
operating system software. It contains the precise machine language required to perform the functions
requested by software applications.
Duplex playback/record audio card
Duplex playback audio cards have two or more channels instead of one for your digital audio to play
through. This means you can do two things at once in terms of playing or recording sound. For example,
it provides you with the ability to overlap spots or songs, creating seamless segues.
Editor Mode
See Production Mode.
End Date
The last valid date a particular audio file is scheduled to be used.
Event
An entry in a program log or List Item. Different types of Events are Application, Text/Tag, Audio, Macro,
Recording, NetShow Scripts, Program Logs, and Video.
Event Variables
A number of variables which can be configured in the bottom section of the Event Builder. They include
Cue, Category, and Scheduled Time.
Fade
A gradual increase or decrease in volume levels.
Frequency
The number of complete sound wave repetitions (cycles) in a given time period. Sound waves and the
electrical signals that represent sound waves in an audio circuit range from a frequency of about 20 to
20,000 repetitions per second. The frequency of a wave determines the pitch we perceive, and is
measured in cycles per second, or Hertz (Hz).
GPI/O
General Purpose Input/Output. These devices are used to create and respond to electrical contact
closures. They correspond directly to Simian’s Trigger and Relay (Switcher) functionality.
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Hertz
The unit of measurement for frequency of oscillation of a sound wave, equal to 1 cycle per second.
Abbreviated Hz. KHz is the abbreviation for kilohertz, or 1000 Hertz.
Hooks
A hook is a segment of an audio cut that contains the most familiar refrain. It is comparable to a movie
trailer or preview. Hooks are set like tones in the Info Editor. By marking hooks in your songs, you can
then add them to a "hooks cart" to play as a preview of upcoming music.
HotKeys
Shortcut keys. HotKeys give live-assist operators (disk jockeys, news people, etc.) the ability to instantly
fire pre-programmed functions, including playing audio files, loading Program Logs, displaying text files,
and launching applications. A HotKey can launch any Simian Event.
I/O Card (Expansion board)
An I/O or Input/Output card is a printed circuit board that plugs into a “port” in your PC and extends the
computer’s ability to control another peripheral device. In other words, it allows you to communicate with
other equipment like satellites, tape recorders and most importantly, the coffee machine. All the boards
(cards) that plug into a personal computer's bus are expansion boards, such as display adapters, disk
controllers and sound cards (audio adaptors).
Intro Time
The “Intro" or Introduction time is useful for Disk Jockeys who want to "talk up" a song. It is the length of
time before the first vocal or music bridge in a song.
Liner
Details given by a Disk Jockey on-air.
Log
See Program Log.
List item
Any of a number of Simian interfaces such as Carts and Sets. These are simply lists of Events.
Live-Assist
The combination of manual and computerized operation of software.
Macros
Commands with user-defined parameters that lets you control functions such as adjusting the auxiliary
and WAV volume of your system, creating programmed fades and setting your system time. They differ
from macros used in other Windows applications in that Simian macros are not scripts (a recorded series
of keystrokes assigned to a single shortcut key), but rather execute single meta commands with userdefined parameters. Simian macros are preset and users cannot create new ones at this time.
Memorized Events
Events that have been added to the Memorized Events window list. This window stores frequently used
events, which is especially useful for macro or Trigger commands that can be complex or tedious to enter
repeatedly.
Mixer
A tool used to combine various audio signals into a common output. The Simian mixer is designed
specifically to let you control the input and output audio volume levels of your system.
Mono
A single digital audio channel (as opposed to stereo).
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Natural Log
Traffic and Billing system from Natural Software. Offers traffic, billing, reporting, data backup/restore
capabilities, account receivable and payables and end of month closing features. Natural Log can handle
two stations within a single billing environment as well as an unlimited number of separately billed clients.
Natural Music
Music scheduling system from Natural Software. Gives you substantial control over your music play list.
The single keystroke interface lets you move through the program quickly and easily. You can schedule
up to 99 different music categories by daypart and separation. Tempo and style information can be used
to design a unique sound for your station.
Measurement Computing
A supplier of digital control equipment. BSI uses Measurement Computing hardware for hardware such
as the Input/Output card that lets your PC interface with external devices such as a Satellite receiver or
tape recorder (AKA: GPIO).
MSMS (NetShow)
A Microsoft application and platform for streaming compressed audio/video over the Internet and
Intranets.
Non-Sequential Start
An option used to start events that you want to execute at a certain time, but aren’t related to the
scheduled events in the current program log. For example, if you want to record a program from a
satellite feed at a certain time. Instead of putting a specific Event in the log, you can just put a nonsequential at the very end of the log and give it a “Non-Sequential Start” Cue in the Event Builder. NonSequential events are now independently executed using the Simian Scheduler.
Overlap (Double, Triple)
Playing multiple audio files at the same time. A double overlap means two files can be heard, a triple
means three files can be heard. This capability requires that you have multiple audio playback devices
available simultaneously.
Peripheral Device
Any hardware device connected to a computer (CPU), such as a monitor, keyboard, printer, disk, tape,
graphics tablet, scanner, joystick, paddle and mouse.
Production Mode
An inexpensive way to have a second copy of Simian to use for production tasks. This is provided so
users can edit logs and carts remotely. Everything will work in this mode except for automated audio
playback from the Main Decks. Check out the Session section of Chapter 3 for more information.
Program Log
A list of items to be played by Simian in chronological order. The log is displayed on the left of the Main
Window. Entries, or items in the log are called Events.
Relay Rack (Switcher)
The circuit board and rack-mount box in a Switcher Kit.
Sampling (Digitizing)
The process of converting an analog to digital signal is known as digitizing or sampling. With audio, the
analog waveform is chopped into a number of slices per second. At each slice, the amplitude is
measured and rounded to the nearest available value. The more chops per second (sampling rate) and
the finer the values assignable to the amplitude (dynamic range), the better the representation of the
original.
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Sample Rate
The rate at which the data in an analog audio signal is measured to form a digital representation of the
sound wave. In a computer, it is impossible to work with an infinite amount of data, which is what would
be required if a continuous wave were to be represented digitally inside the machine, so at every possible
instant in time we would have the measured value of the waveform at that instant. For this reason, it is
necessary to sample sound wave data. Sampling means breaking a wave at various intervals and using
a single measured value to represent all the values in each interval. By dividing the waveform like this,
one second of audio can now be represented by a finite number of values. The sample rate is the
number of measurements taken per one second of audio.
SayTime
Accessory software that allows Simian to say the time of day. SayTime is customizable for your own
voices and the time statement can include a station header (WKRP News time is…). There is also a
macro command with the format SAYTIME.
SayTemp
Accessory software that allows Simian to actually speak the current temperature. SayTemp is
customizable for your own voices and the time statement can include a header (Current temperature in
Cincinnati is…).
Sectone
“Sectone” or “Sec Tone” is a broadcast term related to the use of magnetic tape cartridges or carts.
Sectone is short for secondary tone and indicates the point, or cue, near the end of a song where it’s OK
to begin playing the next event. It is the starting point of the “Segue”.
Segue
A transition between two audio segments. The segue length is the time during which two consecutive
audio segments overlap or are played simultaneously. The sectone setting determines the segue length.
Sound
When objects vibrate or collide, they produce an excitation of the molecules in the surrounding air. If the
resulting vibrations are within a certain frequency range, we sense it in our eardrums as a change in air
pressure. Our brain then interprets this as sound. Sound waves move in all directions outward from the
original disturbance like the ripples created from a stone dropped in a pool of water.
When sound is recorded through a microphone, the changes in air pressure cause the microphone's
diaphragm to move in a similar way to that of the eardrum. These minute movements are then converted
into changes in electrical signals. All sound cards generally produce sound in this way, only in reverse.
They create or play back sound waves. The changes in voltage are then amplified, causing the
loudspeaker to vibrate, which in turn cause air pressure changes which are interpreted by humans as
sound.
The frequency range of vibrations felt by humans is between 20 and 20,000 cycles per second. This
gives us the sensation of pitch, harmonics, tone and overtones. Frequency is measured in Hertz (Hz).
One Hertz is one wave repetition or cycle per second.
Sound Card
The expansion board in your PC that enables it to play or record digital audio files. The modern PC
sound card contains several hardware systems relating to the production and capture of audio. The main
systems capture and replay digital audio. Sound waves from these systems are produced by playing a
digitized (or sampled) sound.
The digital audio section of a sound card consists of a matched pair of digital-to-analogue (DAC) and
analogue-to-digital (ADC) converters and a programmable sample rate generator. The computer reads
the sample data to or from the converters.
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SoundHound
An application that manages your audio file database. It sits on your Windows taskbar and can be
accessed by double-clicking the binoculars icon. Auto launch and exit functions for SoundHound are in
the Tools/Hardware Options menu in the Playback tab.
Speedy (BSI Product)
Automated CD-to-PC dubbing. The recording system automatically dubs, names and tags each song for
you. Transfer one, several or all tracks easily. Audition songs before dubbing if desired. Speedy does
not dub faster than normal dubbing -- it automates the process.
Spot
A commercial or advertisement.
Start Date
The first scheduled date for use of an audio file.
Stereo
Two channels playing spatially related audio signals.
Stinger (BSI Product)
Instant Audio Player that gives you fast, easy access to your sound effects, liners, beds and bits. Up to
288 audio cuts can be instantly available for playback in Stinger and each has its own on-screen
description and button which can be color-coded. Supports drag and drop manipulation.
Streaming Audio
Audio transmission over a data network. The term implies a one-way transmission to the listener, in which
both the client and server cooperate for uninterrupted sound. The client side buffers a few seconds of
audio data before it starts sending it to the speakers, which compensates for momentary delays in packet
delivery.
Switcher
A General Purpose Output device that creates contact closures via the RELAY macro in Simian.
An electronic signal is sent from Simian to an external device such as a tape recorder or satellite.
Switches are sent through a special device on an audio card or specific purpose I/O card. Depending on
the input hardware you install, up to 24 Triggers can be programmed to launch various events. The
settings for the Triggers can be saved as sets. The sets can be changed via the program log so that
Simian can perform different functions with different sets loaded. This is very useful for stations that use
more than one broadcast network.
Switcher Kit
A BSI product that includes the hardware, software and drivers necessary to control external devices
through Simian. The kit includes an I/O card, a circuit board with 24 external Relays to switch external
audio and control lines and all the necessary cables and software. Switcher commands can be executed
via the program log, a HotKey or Trigger.
Tag
A live “add-on” to a commercial spot. A piece of text typically read by a Jock after a generic commercial
which customizes the ad by giving additional local or specialized information.
Time Events
Includes “Timed Start Immediate”, “Timed Start Next”, and “Timed Non-Sequential” events. These will
occur at the time set in the time box (in 24-hour time) regardless of whether something is already playing
or not. Time events are indicated by an "@", “#”, or “N” sign in the "Cue" column of the program log. The
scheduled time is indicated in the “Scheduled” column. Start Next events are similar to Timed Start
events, except that they will allow currently playing audio file to finish before they start.
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Time-Shift Recording
A new feature of Simian that allows you to record and playback a file simultaneously. This means you
can start recording a network program (via satellite for example) and begin playing it back on-air at a
scheduled time even though the program is still recording at the other end of the file. Previously, you
would have to wait for the entire recording process to complete, close the file, and then reopen it and play
it back. This would often disrupt schedules unnecessarily.
TimeSync
A macro command which turns time synchronization on or off. Example: TIMESYNC ON would tell
Simian to look for a time synchronization Trigger according to the TimeSync settings established in
Tools/Program Options on the General tab.
Traffic System
A software system used to manage commercial scheduling and billing functions.
Triggers
An electronic signal from an external source such as a satellite that is received and interpreted by Simian.
Triggers are received through the PC game port or a special I/O card.
Trigger Kit
The BSI Triggers Kit provides Simian with 24 incoming “Triggers” to respond to external contact closures
from satellite receivers, audio mixers, tape decks and other equipment. The kit includes an I/O card with
resistors installed, a connection cable, a MINI-37 terminal board and software drivers as well as the
installation and wiring documentation for the kit.
Voice Track
A digital audio segment of a voice recording associated with one or more songs (cuts). A Voice Track
can serve as an introduction to a cut (also called “talking up” or making an “intro”), as an announcement
after the cut has played (a “back announcement”) or as a “bridge” which gives information about what has
just played and also what is coming up next.
Wave file
A standard sound (audio) file in Microsoft Windows. Wave files have the file extension WAV.
WaveCart (BSI Product)
On-screen “cart machine” that displays up to ten decks full of audio files and gives you instantaneous,
crystal clear playback. WaveCart supports spot rotation and can also play more than one spot at a time.
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